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GRAPHICS →YES, SIZE 
DOES MATTER!

Computer Science 1033 – Week 3

Afternoon, n.:

That part of the day we spend worrying about how we wasted the

morning.→ Unix Fortune Slide 2 of  52

Poster Assignment Hints
 Follow the instructions 

carefully, for example: 

◦ you get 2 marks if you 

named your files as stated 

in the instructions!

◦ If you get a mark for every 

requirement we ask for.

 DON’T Collapse your 

layers

 Name your layers with 

good names

 Check for spelling

 Text:

◦ Contrast

◦ Edges

 Images

◦ Crisp

◦ Appropriate

 Colours
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Hints on Assignment
 Use the shape tool to create:

◦ A shape, you can use the custom 

shape tool

◦ Give the shape a good name, 

don’t collapse the layers
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Poster Assignment Tips

 Check that you have all the required 

criteria such as a shape from the shape tool.

 Remember to follow the CRAP rules!

 Other tips

 Colour Choices →

https://color.adobe.com/create

and http://design-seeds.com/
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Remarks (called Disputes in Kritik)
 Your poster will be marked by your peers. 

 There are several rubric items, you can see the rubric items BEFORE the 

assignment is due, so check them out to do better.

 If the rubric item is NON subjective, you will get the majority (mode) 

mark for the item (i.e. if 4 out of 5 graders gave you 1 out of 4 and the 

last grader gave you 4 out of 4, you will get 1 out of 4, not the average 

(not (1*4+4)/5 = 1.6).

 If the rubric item is subjective, you will get the average mark for the item 

(i.e. if 4 out of 5 graders gave you 1 out of 4 and last grader gave you 4 

out of 4, you will get 1.6 out of 4)

 You can dispute your mark but we will ONLY check the non subjective

rubric items, not the subjective ones. We will not change the subjective 

ones. 

 Please wait till you can see your completed rubric and read your entire

rubric over carefully before entering a dispute. If you still want to dispute, 

only list the rubric item numbers that were marked incorrectly in the

dispute.
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Big Ideas for This Weeks

 Big Idea 1: Mo bits per pixel … Mo Colors!

 Big Idea 2:  Bitmapped vs Vector:  Thumbnail 

Vectors Icons on the size of a bus?  IT IS 

DOABLE! 

 Big Idea 3: Mo bits, Mo problems! (The 

more bits you have to transmit, the slower 

your image will load unless you compress)

 Big Idea 4: Go Smaller or Go Compressing!

http://www.youtube.com/watch?v=iYhCn0jf46U
http://www.csd.uwo.ca/~lreid/cs1033/ExamplesForColourMarking.pdf
https://color.adobe.com/create
http://design-seeds.com/
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Readings

 Textbook readings:

◦ Understanding Computers

 Files and Folders

◦ Graphics

 Basics of Graphics *

 Digitized Images *

 File Size (first portion of Image Formats and Compression 

Techniques)

◦ * These two readings were suggested in previous weeks 

too. You don't have to read them if you did before!
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Overview of Today’s Topics

 Sampling an image

 Black and White, Gray and True Colour

 Indexed Colour

 Review and worksheet

 Bitmaps vs. Vectors

 Image file size

 Why we need compression
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Quantizing The Image

 Now that we know how many pieces our image 
will be broken into, how many colours will we 
have available to represent each pixel?

 Assume for each pixel we have 1 bit to 
represent the colour.

 1 bit can hold either 0 or 1

◦ 0 could be white

◦ 1 could be black

 Thus 1 bit allows for 2 colours, usually black and 
white (21 

→2)
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 How many colours can 2 bit hold? 22 
→4

◦ 00 →White

◦ 01 → Light Gray

◦ 10 → Dark Gray

◦ 11 → Black
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Does 1 bit colour look realistic?

 YES → Can you tell what this image 

represents?
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2 Bit Colour

 4 shades of gray



1/3/2022

3

Slide 13 of  52

More bits, more shades of gray

 4 bit colour → 24
→ 16 Shades

0000 0001 0010 11110011

How many shades of gray will 8 bits 

give us?

http://www.modernimaging.com/bit_depth.htm

If this image was 400 pixels by 300 pixels and we used 1 byte (8 bits) 

for each pixel, the file size would be:

• 400 X 300 X 1 byte → 120,000 bytes or ~120 kilobytes
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How about some Colour? Subtractive Model - CMYK Additive Model - RGB

 Used for printing

 Ink applied to paper

 Primary Colours → Cyan, 

Magenta and Yellow

 Ink when applied removes 

(subtracts) the white

 Use on monitors

 “Adding” light to a black 

background (the monitor)

 Primary Colours → Red, 

Green and Blue

Slide 17 of  52

How do we represent the colours on a 

Monitor?
 True Colour

◦ Can represent 224 colours → about 16 million 

different colours

◦ 224 = 28 X 28 X 28 = 256 shades of red, X 256 

shades of green X 256 shades of blue

◦ Need 3 bytes (remember: 1 byte=8 bits) for True 

Colour (1 byte for red, 1 byte for green, 1 byte 

for blue)
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2 Ways to encode True Colours

 1. <RGB>  <amount of Red, 
amount of Green, amount of 
Blue>  DECIMAL NUMBER

◦ Where 0 is no amount and 255 is the 
most allowed

◦ <255, 0, 0> → the most of red, no 
green, no blue

◦ <0, 255, 0> → the most green, no red, 
no blue

◦ <100,100,100> → equal middle 
amounts of red, green and blue

◦ <50, 0, 200> → a little red, a lot of blue

◦ <200, 0, 50> → a lot of red, a little blue

http://www.modernimaging.com/bit_depth.htm
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 2. Hexadecimal Code
◦ #RRGGBB → RR are the digit place holders for the amount 

of red, GG amount of Green, BB amount of Blue

◦ Amounts are counted in hexadecimal with these digits: 
0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F

◦ 00 still means 0

◦ Hex FF= Decimal 255 (try the calculator to see)

◦ Hex to Dec → 00=0, 01=1, 02=2, 03=3, 04=4, 05=5, 06=6, 07=7, 
08=8, 09=9, 0A=10, 0B=11, 0C=12, 0D=13, 0E=14, 0F=15, 
10=16, 11=17,….. FD=253, FE=254, FF=255.  

◦ #FF0000 → Red

◦ #00FF00 →Green

◦ #000000 → Black

◦ Question: what is the hex for WHITE?

Some hexadecimal colours:

Question: Are these colours the same:

• <0,0,0> and #000000?

• <0,0,0> and #000000?

• <9,8,7> and #090807

•<10,15,09> and #__ __ 09

• <255,0,255> and #FF00FF

• <255,0,255> and #FF00FF

• <66,0,99> and #660099 ? 

• <66,0,99> and #660099 ? NO
http://easycalculation.com/color-coder.php

http://easycalculation.com/rgb-coder.php

0A 0F
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Can you represent the same number 

of colours using Hex as using RGB
 YES

Red Green Blue How many colours?

Smallest Value (RGB) 0 0 0

Biggest Value (RGB) 255 255 255

Total number of shades 

you can represent

256 256 256 256X256X256→16 

million colours

Smallest Value (Hex) 00 00 00

BiggestValue (Hex) FF FF FF

Total number of shades

you can represent

16X16→

24X24
→28

16X16→

24X24
→28

16X16→

24X24
→28

28 X28 X 28   
→224

→16 

million colours

Smallest Value (Binary) 00000000 00000000 00000000

BiggestValue (Binary) 11111111 11111111 11111111

Total number of shades

you can represent

2X2X2X2

X2X2X2X

2→28

2X2X2X2

X2X2X2X

2→28

2X2X2X2

X2X2X2X

2→28

28 X28 X 28   
→224

→16 

million colours

https://www.rapidtables.com/convert/number/hex-dec-bin-converter.html
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How many colours do we need to 

encode?

 QUESTION: Roughly, what is the 

maximum number of colours the 

human eye can detect?

◦ Less than 10 million
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Colour Continued…Indexed Colour 

(not true colour)
 Sometimes we don’t need 16 million colours, then 

we use indexed colour (an index that maps to a 

group of colours we plan to use)

 QUESTION: What types of images don’t need a full 

palette of colours?

 Our index might be 8-bits→ 28 different colours 

(just like with gray shades) thus we can show 256 

different colours.

 Called the Image Bit Depth, e.g. 8 bit depth

 We only index the colours we need (if we will never 

use purple in our image, don’t need to include it in 

the index of colours)

Why do the bottom 

boxes appear to have 

no colours in them?
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Indexed Colour

 Indexed Colour can look pretty good even 

though we will only ever have at most, 8-bit 

colour (or 256 shades of colour)

http://www.csd.uwo.ca/~lreid/cs033/BitDepth/

http://easycalculation.com/color-coder.php
http://easycalculation.com/rgb-coder.php
https://www.rapidtables.com/convert/number/hex-dec-bin-converter.html
http://www.csd.uwo.ca/~lreid/cs033/BitDepth/


1/3/2022

5

Slide 25 of  52

Review:

 Match the encoded colour to the correct 

colour name:

Encoded Colour

a) #FFFFFF
b) #00FF00
c) #FAFAFA
d) <0,0,255>
e) <0,0,0>
f) <14,14,14>
g) <125,125,125>

Colour Name

1. White
2. Black
3. Dark Gray
4. Light Gray
5. Medium Gray
6. Bright Green
7. Bright Blue

Encoded Colour

a) #FFFFFF
b) #00FF00
c) #FAFAFA
d) (0,0,255)
e) (0,0,0)
f) (14,14,14)
g) (125,125,125)
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Bitmapped Images vs. Vector Graphics

 Bitmapped Graphic Image

◦ Image consists of pixels in a grid

◦ Icons are an example of a bitmapped 

image (do you recognize this icon? → )  

Icons are usually 32 pixels by 32 pixels

◦ When bitmapped images are enlarged 

(resampled), the computer adds new pixels 

and guesses on the colour to colour the 

new pixels (called interpolation) based 

on surrounding pixels

◦ This icon is now 245 pixels by 245 pixels

◦ Bitmapped images edges become jagged
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Bitmapped Images

 Also called raster graphics image
 Bitmapped images are resolution 

dependent
◦ Bitmapped image on a 640 by 480 

screen (lower resolution) appear 
larger than on a 1280 by 1024 screen 
(higher resolution)

 Bitmapped images that are 
enlarged:
◦ Have larger file size than original

◦ Become distorted

 All images from scanners and digital 
cameras are bitmapped images
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Common Bitmap Formats
 Common bitmap file formats are:

◦ BMP (has little compression, makes big files!)

◦ GIF

◦ JPEG, JPG

◦ PNG

◦ PICT (Macintosh)

◦ PCX

◦ TIFF

◦ AFPHOTO (Affinity Photo)

◦ PSD (Adobe Photoshop)

 Popular bitmap editing tools/software packages:

◦ Microsoft Paint

◦ Adobe Photoshop

◦ Affinity Photo

◦ Corel Photo-Paint

◦ Corel Paint Shop Pro

◦ The Gimp
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Vector Graphics

 Vector image is made up of individual, scalable 

objects. 

 Objects are defined by mathematical 

equations

 Objects consist of lines, curves and shapes

 No distortion as image is enlarged
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Vector Graphics
 As image is enlarged, still has crisp clean lines.
 Most browsers don’t display vector graphics 

without a plug in. 
 Only can be used with drawings, not 

photographs

 Usually vector graphic image has a smaller file 
size than the same image stored as a bitmap.

 Below: enlarging and shrinking an image: left 
using a vector graphical image, right using a 
bitmapped image
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Vector Images
 Example: HTML 5 allows it now: 

https://www.w3schools.com/graphics/svg_inh

tml.asp

◦ Try changing the values

 Great for logos because

◦ Can be scaled down for business card

◦ Can be scaled up for a trade show poster

 https://youtu.be/PJFc3KlEdLM?t=61 (watch till 

about minute 4)

 Note: the text in PDF files are Vector based 

(but not the images in a pdf file) Slide 32 of  52

Common Vector File Formats
 Common Vector file formats include:

◦ AI (Adobe Illustrator)

◦ CDR (CorelDRAW)

◦ CMX (Corel Exchange)

◦ CGM Computer Graphics Metafile

◦ DXF AutoCAD

◦ WMF Windows Metafile

◦ EPS (Encapsulated PostScript)

◦ PDF

 Popular vector drawing programs/software packages are:

◦ Adobe Illustrator

◦ Affinity Designer

◦ CorelDRAW

◦ Xara Xtreme

◦ Serif DrawPlus
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Activity 1

 Open MS Paint  

(Start>Programs>Accessories>Paint)

 Pick the text tool, set the font to 50pt, type 

in your name

 Pick the text tool again, set the font to 12pt, 

type in your name

 Select the small font and resize it to the size 

of the big font

 Do they look the same?
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Activity 2

 Draw an oval in MS Paint, then select it and 

resize it, watch what happens

 Draw an oval in Affinity Photo, 

◦ Select Layer>Layer Style and give it an outline 

(Stroke)

◦ Select the oval layer and select Edit>Transform 

Path>Scale and resize it, watch what happens.

 Usually when you see the command 

“Document>Flatten” in Affinity Photo, it is 

changing your Vector layers into a one flat 

Bitmapped layer!
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Try it out

 http://www.csd.uwo.ca/~lreid/cs1033/vectors/

star.html

 https://upload.wikimedia.org/wikipedia/comm

ons/e/e6/Phone.svg
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Bitmapped Graphics vs. Vector Graphics
 Question:  Which of these statements do 

you think is TRUE: A or B?

A: You can convert a vector graphic image into a 

bitmapped image easily but you cannot easily 

convert a bitmapped image into a vector graphic 

image. 

B: You can convert a bitmapped image into a vector 

graphic easily but you cannot easily convert a 

vector graphic image into a bitmapped image. 

https://www.w3schools.com/graphics/svg_inhtml.asp
https://youtu.be/PJFc3KlEdLM?t=61
http://www.csd.uwo.ca/~lreid/cs1046/flippedclassroom/FlippedOne/flippedclassroom1.pdf
http://www.csd.uwo.ca/~lreid/cs1033/vectors/star.html
https://upload.wikimedia.org/wikipedia/commons/e/e6/Phone.svg
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How to lose customers before you 

ever even had them!

 Have you ever gone to a website and then left 

within seconds because the graphics were 

taking too long to download? 

 Do you ever return?

 http://www.flamingpear.com/examples-

sbp/images/blue-green-sea-large.jpg

 http://www.csd.uwo.ca/~lreid/cs1033/resolutio

n/UncompressedGraphics.html
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How Big Is An Image?
 Let’s figure out how many bytes one large picture in true colour (224 colours) would take up. 

 Roughly:

 Total Numbers of pixels (Sampling) * Colour Big Depth (Quantize) 

 Length (px) * width (px) * Colour bit depth(bytes)

 Question:  Assume we have a picture that is:
◦ 1600 pixels by 1200 pixels (takes up the whole screen and more depending on your resolution)

◦ Each pixel will need 3 bytes (8 bits for red, 8 bits for green, 8 bits for blue) to represent the colour of each pixel <R,G,B>

◦ How many bytes, kilobyte and megabytes is the image? →

◦ 1600 * 1200 * 3 = 5,760,000 bytes

◦ 5760000/1024 = 5625 Kilobyte

◦ 5625/1024 = 5.5 Megabytes

◦ Save a picture this size in Affinity Photo as .raw to find size

◦ http://www.csd.uwo.ca/~lreid/cs1033/resolution
 Look at the size of the file with the extension .raw

UNITS OF MEASURE:

 How about kilobytes, megabytes, etc?

 1 KB = 1024 B

 1 MB = 1024 KB

 1 GB = 1024 MB

 1 TB = 1024 GB

* Some people use 1000 for these conversions.

We need to decide what are we 

going to use the image for?

For Printing in a Flyer or 

Magazine:
For Displaying in a Web Page:

 File size doesn’t matter

 Most important issue is 

the quality of the image!

 Image will be printed 

with at least 300dpi

 File size is very important

 Bigger files take longer to 

download

 Quality is important too but 

want to try to get best quality 

with smallest file size.
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How long will it take that uncompressed 

sunset image to download if we are 

using it in a webpage?
 If the client is using 

high speed connect at 
1500 kilobits per 
second?

 If the client is on a 
modem that is 56 
kilobits per second

 On a really old modem 
that is 28.8 kilobits per 
second?

 33 Seconds

 860 Seconds or 
14.33 Minutes

 1672 Seconds 
or 28.66 
Minutes
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We need to make our webpages

download as fast as possible

 We want them to be the “appropriate size” 

for our page, in terms of proportion

 Want the image to look good (“high 

quality”)

 Want image to download quickly

 THUS  WE NEED TO MAKE OUR IMAGE 

FILES SMALLER BUT OUR IMAGE TO 

STILL LOOK GOOD!

Below, 

-Image size isn’t appropriate

-Doesn’t look good 

-BUT it does download faster than 

the top page because the image is 

smaller

http://www.flamingpear.com/examples-sbp/images/blue-green-sea-large.jpg
http://www.csd.uwo.ca/~lreid/cs1033/resolution/UncompressedGraphics.html
http://www.csd.uwo.ca/~lreid/cs1033/resolution


1/3/2022

8

Slide 43 of  52

How do we download faster?

Make our image file size smaller!

Question: What can we do to make our 

images smaller?

 OPTION 1: Make the image be 

physically smaller  → LESS PIXELS 

(BUT that will change the size it is displayed 

at on the screen). 
 For example, a 100 pixel by 100 image pixel (30KB) is 

smaller than a 200 pixel by 200 pixel image (118KB) 100 by 100 pixels

Did you really want the 

polar bear to be this 

small?

200 by 200 pixels

This is how you wanted 

the image to look within 

your page!
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How do we download faster and keep 

the image the size we want it?

 OPTION 2: COMPRESS  THE IMAGE 
FILE:  use tricks to make file smaller without 
losing the quality of the image or the size (in 
pixels of the image)

 Still 200 pixels by 200 pixels but the file size is smaller 
than the original.

 An uncompressed image that is:
 200 by 200 pixels

 True Colour (16 million colours → <R,G,B>)

 Will be 200 * 200 * 3 bytes = 120,000 bytes

 Will be 120,000 / 1024 = 117.2 Kilobytes

Slide 46 of  52

Compression To The Rescue!
 The same image that is:

 200 by 200 pixels

 Original size was 118 kbytes (200*200*3/1024)

 Looks almost like true colour when:

 SAVED AS A COMPRESSED JPG WILL BE:

 Highest Quality → 58 KB

 Lowest Quality → 25 KB

 SAVED AS A COMPRESSED GIF WILL BE:

 256 Colours →29KB

 64 Colours →17KB

 16 Colours →7KB

 10 Colours →3KB

Lowest Quality JPG

25KB

Highest Quality JPG

58 KB

Raw Image

118KB

256 Colours GIF

29 KB

64 Colours GIF

17 KB
16 Colours GIF

7 KB

10 Colours GIF

3 KB

Note: this one is 40 times than the 

uncompressed file smaller BUT the 

quality of the image is very poor!
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Compression

 Key Concept: Compress as much as you can 

WITHOUT sacrificing quality (losing 

information)!

 Is there a way we can stuff the bits and bytes 

down into less bits and bytes? 
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Two Types of Compression
 Lossless:

◦ Compress the original bits and bytes into less 
bits and bytes without losing any of the original 
information about the picture

◦ When we reopen the file, all the original 
information about the picture is still there!

◦ NO INFORMATION IS LOST

 Lossy:

◦ When compression occurs, some of the original
information is lost 

◦ Selected portions of the image are discarded but
the selected portions are the ones that will be 
the ones that least missed or noticed

◦ CANNOT GET THIS INFO BACK ONCE IT IS DISCARDED

◦ Nerf Ball vs. Orange☺
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Several different algorithms for (ways 

to perform) compression
 Each different type of image file format 

represents the use of a different compression 
algorithm

 Common compressed image file formats that 
are acceptable on the World Wide Web:

◦ gif

◦ jpg, jpeg

◦ png

 Uncompressed file formats:

◦ bmp (for Windows)

◦ raw (common on digital cameras)


